
Creating Web Pages with DreamWeaver 
Prepared by Dr. Sheila Offman Gersh 

Before Starting DreamWeaver:  Create a new folder on the Desktop where you 
will save the pages, images, etc.  Later you will transfer it to a disk. 

Starting  DreamWeaver  
Click File, New.  In the New Document Dialog pages, select BASIC PAGE category and 
then select HTML.  Click the CREATE button. 

  
To create a web page, use one of the methods described below. Once you've started a 
page, you can add and edit text just as you would in a word processor.  When you first 
start decide where you want to save all of your files -- either in one folder on the desktop 
or on a disk.  Later they could be uploaded to a server. 

To start from an HTML  file (a Web page that your created using another software 
(ex. Word, FrontPage, Composter, etc.) stored on your local drive: 

1. Open the DreamWeaver  
2. Open the File menu and choose Open File. You see the  File dialog box. 
3. On your local drive, locate the file that you want to edit. 
4. Click Open to display the specified file in the DreamWeaver window. 

NOTE:  If you want to transfer text that exists as a word processing document or a 
spreadsheet, you must open the document its program, select it (highlight by dragging the 
mouse over the the text you want to transfer)  and go to your DreamWeaver file and 
PASTE it into the page by selecting Edit, Paste.  It will retain the formatting, including 
the fonts, paragraphs, color, etc. 
 
Before starting the web page, you should become familiar with the Property Inspector at 
the bottom of the page.  This panel enables you to set properties for the selected object 
(ex. text, image, etc.) and it presents the available properties of whatever object is 
currently selected. (You will use this panel throughout your webpage creation.) 

Creating and Formatting Text 
Use the Property Inspector for the following: 
FORMAT:  heading format:  size 1-6 (the smaller the number, the larger the text) 
                  paragraph -- adds 2 carriage returns 
                  Break -- starts a new line (shift-enter) 
                  Text -- sizes the text 



                  Font - specified a group of font (will almost guarantee one will be on any 
browser)     
                  Text color - chooses a color for selected text (colors are express in 
hexadecimal (ex. Red=#FF0000) 

1. Click  to place the insertion point anywhere within the text that you want to 
format. Select (highlight) the text you want to format. 

2. Using the drop-down list in the Property Inspector item, choose the level of 
heading you want, from 1 (largest) to 6 (smallest).  For example, choose "Heading 
1" for your main heading, "Heading 2" for the next level, and so forth. 

3. Use other parts of the Property Inspector to do other kinds of formatting. 

Creating Lists and Indenting Text 
        
       1. Type 4 items pressing ENTER after each one. 
       2.  Drag cursor of all items to select them. 
       3.  Selected UNORDERED list in the Property Inspector.  The items will have a 
bullet in front of them.  

1. Click to place the insertion point within the line of text that you want to format 
2. Choose the list style from the Property Inspector:  or   

3.  
o Bulleted: Each item has a bullet (dot) next to it (as in this list).   
o Numbered: Items are numbered.   

Tip: You can quickly apply a list style to a block of text by selecting the text and clicking 
the Numbered List  or Bulleted List  buttons. 

To align a paragraph or text in your page, for example, centering or aligning to the left or 
right: 

1. Click to place the insertion point within the paragraph or line of text you want to 
align. 

2. Open the Format menu and choose Align; then choose an alignment option. 

Note: You can also use the Propery Inspector  to align text. 

Adding a Separator to a Page:  The Horizontal Rule 
Horizontal lines are typically used to separate different sections of a document visually. 
 To insert a horizontal line (also called a rule): 
Click.---> Insert---> HTML---> Horizontal Line 



Setting Page Properties 
Use Page Properties in the Property Inspector.  When the Page Properties dialog box 
opens, you can do the following. 

1.  Add a Page title -- click "General" under Category, type a title and click "ok" or 
"apply" 

2.  Setting the Page Appearance -- Click Appearance under Category to choose the 
font, text size, text color, background color and/or background image.  Click "ok" 
or "apply".  If you want the background of your page to be an image, type the name 
of the image file or click Browse to locate the image file on your hard drive or disk. 

Inserting a Table 
Tables are useful for organizing text, pictures, and data into formatted rows and columns. 
To insert a table: 

1. Click to place the insertion point where you want the table to appear. 

2. Click the Table  icon on the  insert bar or choose Insert, Table. .  The Table 
dialog box appears. 

3. Type the number of rows and columns boxes.   
o  Enter a size for the table width, and select either percentage of the 

window or pixels. 
4. Enter a number for the border thickness (in pixels); enter zero for no border.  (The 

higher the number the the thicker the boarder) 
5. Click OK when you are done.   

Note: DreamWeaver  uses a double dotted line to indicate tables with a zero 
border; the dotted line disappears when the page is viewed in a browser. 

6. Click OK to confirm your settings and view your new table. 
7. If you want to edit the settings in the table, click on the table icon to change the 

cell padding and cell spacing. 
o Cell Padding -- This is where you set the amount of space between an 

object contained in a cell and the border of the cell.  It's the padding that 
sits between the contents of the cell and the cell border. 

o Cell Spacing -- This is where you set the amount of space between two 
cells.  This setting controls the amount of space between cells. 

8. If you want to insert rows or colums after you started working with the table, click 
the mouse where you want to insert a row or column and then click insert on the 
tool bar.  Click "table objects" and you will get a list of items that you can insert. 
 Click on the appropriate item. 



Changing a Table's Properties 
This section describes how to modify properties that apply to an entire table as well as the 
rows, columns, or individual cells within a table.When you click any place on the table 
the Table Properties box  (similar to the Property Inspector) will appear at the bottom of 
the screen.: 

1. Select the table, or click anywhere inside it. 
2. When you click on a portion of the  table, the Property Inspector shows different 

the attributes for that section.  If you select the entire table, you will see a 
different properties box. 

3. When you click the Table you can change the following properties 
o Table width and height:   Use this to specify the number of rows and 

columns. Enter the width of the table and then choose "% of window" or 
"pixels." If you specify width as a percentage, the table's width changes 
whenever the Composer window's or browser window's width changes. 

o Borders, Padding  and Spacing: Use this to specify, in pixels, the border 
line width, the space between cells, and the cell padding (the space 
between the contents of the cell and its border). 

o Table Alignment: Use this to align the table within the page. Choose an 
option from the drop-down list. 

o Background Color: Use this to choose a color for the table background, 
or leave it as transparent. 

To view, change, or add properties for one or more cells: 

1. Select the row, column, or cell, The Table Properties will appear in the Property 
Inspector dialog box appears. 

2. When you click the Cells  you can edit some properties also. 

Tip: To change the text color or background color of one or more selected cells or the 
entire table, select the items in the Property Inspector.  For example Bg is for 
background color 

Tip: To change the color of cells  select the cell, then click on the Bg box. 

Adding and Deleting Rows, Columns, and Cells 
DreamWeaver allows you to quickly add or delete one or more cells, columns, or rows in 
a table.  

To add a cell, row, or column to your table 

1. Click inside the table where you want to add a cell (or cells). 
2. Open Insert  in the menu  bar  and then choose Table Objects. 



3. Choose one of the items that indicates what you want to do. (ex. insert row below, 
insert row above, etc.) 

To delete a cell, row, or column: 

1. Click a row, column, or cell to place the insertion point. Or, select neighboring 
cells to delete more than one row at a time. To select neighboring cells, drag over 
the cells you want to select. To select individual cells in a table, hold down the 
Ctrl key (Windows) or the Command key (Macintosh OS) and click on the cells 
you want to select. 

2. Click  Modify in the menu bar, then click table and choose the item that applies to 
what you want to do. 

To join (or merge) a cell with the cell on its right: 

• Select adjacent cells.  On the Property Inspector, click the merge (join) icon in the 
Property Inspector. 

To split adjacent cells: 

• Select a cells by dragging over it 
• In the Property Inspector, click the split cell icon.  

Inserting an Image into Your Page 
You can insert GIF, JPEG, BMP, and PNG (Portable Network Graphics) images into 
your web page. You can also use them to create links.  

Note: If you plan to publish your pages to the web, it's best not to use BMP images in 
your pages. 

Tip: It's best to first save your page before you insert images into it.  You should also 
have the image files in the same folder or on the same disk as your pages. 

To insert an image: 

1. Click to place the insertion point where you want the image to appear. 
2. Select the Image command from the Iinsert bar, or open the Insert menu and 

choose Image. You see the Image Properties dialog box. 
3. Type the location and filename of the image file, or  search for the image file on 

your hard drive or your disk. 
4. Click OK 

Editing Image Properties 



Once you've inserted an image into your page, you can edit its properties and customize 
the layout in your page, such as the height, width, spacing, and text alignment. If you are 
not currently viewing the Image Properties Inspector dialog box, follow these steps: 

To edit the properties for a selected image: 

1. Click the image,  to display the Image Property Inspector dialog box at the 
bottom of the screen. 

2. Now you can do any other following: 

• Alternate Text: Enter text that will display in place of the original 
image; for example, a caption or a brief description of the image. 
It's a good practice to specify alternate text for readers who use 
text-only web browsers or who have image loading turned off. 

• Resize Picture -- You can resize the picture by changing the 
height or width.  The other dimension automatically changes when 
you change one dimension. 

• Align Image with Text--  The align drop-down menu  controls 
how objects (text, etc.) that are located beside an image.   

• Create a Linked Image  (Using an image as a link)--If you want 
to be able to click the image to hyperlink to a Web site, type a 
URL in the Link box.  Click on the Point-to-File icon (folder) to 
link to a file.  You can now browse for the file that you want to 
create a link. 

• Create a Border -- If you want to create a border around the 
picture, please  a number in the number box.  The larger the 
number, thicker the border. 

Creating Links  
To create a link to another web site, type the  url, including http:// in the link box in the 
Property Inspector. 
To create a link to an e-mail address select text to be the link.  Click the Email Link 
object on the Insert bar and the Email Link dialog box appears. Enter the e-mail address 
OR  you can type mailto:and the e-mail address in the link box. (ex. 
mailto:jsmith@hotmail.com) (Do not leave a space after mailto:)  

Creating Links Within the Same Page 
To create a link within the same page, for example a link that the reader can use to jump 
from one section to another, you must create an anchor (target location), and then create 
a link that points to the anchor. Anchors are also called named anchors. 



1. Click to place the insertion point where the named  anchor will be located  This is 
the area of the page where the user will jump when he or she clicks the link to the 
named anchor. 

2. Select Insert. and choose Named Anchor or select the Names Anchor in the 
Common panel of the Insert bar. You see the Named Anchor Properties dialog 
box. 

3. Name the anchor in the Anchor Name. 
4. Click OK. An anchor icon appears in your document to mark the anchor's 

location:  

To create the link on which readers can click to jump to the anchor: 

1. Select the text or image that will to link to the named anchor. 
2. In the Link box type the name of the named anchor, preceded by a pound sign. 

(for example #lesson)  
3.  

Note: To test the link you just created, open the File menu and choose Preview in 
Browser, then click the link. 

Creating Links to Other Pages 
You can create links from your page to local (other) pages you created  on your own 
computer or to remote pages on the Internet. 

Tip: It's best to first save  your page before you create links to other pages.  

To create a link to another page: 

1. Click to place the insertion point where you want to create a link, or select the text 
or image that you want to link to the anchor. 

2. In the Link box, type the name of the  file or click Point-to-View icon to locate the 
file. 

To review the various links that you can create: 

o Link text (other pages you created):In  the Links box type the  file name 
or  locate  and select the file you want to use as a link.   

o Link Location: Type URL of the Web page  you want to link to.   Make 
sure you begin the url with http:// 

o Link to an e-mail address:  Begin the link with mailto: and then type the 
e-mail address. 

 Note:  To test the link you just created, click the Browse button and then click the link to 
make sure it works as expected.  



Saving and Browsing Your New Page 
To save a document:: 

• Open the File menu and choose Save As the first time you save;  after that you can 
click File, Save;  You can also Save to Remote Server (described later).  

If you haven't already given your page a title, you will be prompted to provide a 
name. 

DreamWeaver then prompts you to enter a filename and specify the location 
where you want to save the file. Make sure you preserve the .html extension in the 
filename. The first page of a Web site should be named index.html 

To change the filename or location of an existing HTML file: 

• Choose Save As and select a different filename or location. 

Note:  All images must be saved as separate files or they won't be seen on your page. 

 
 
 
 
 


